Dearborn Protocol Adapter 5 Series

DGDPMA5MA – Multi-Application Drivers

Installation and User Manual

DGDPMA5MA Driver Version: 1.29
DGDPMA5SA Driver Version: 1.29
Native Drivers Version: 10.09
DPA 5 Dual CAN / Bluetooth Firmware Version: 65.113
DPA 5 Quad-CAN Firmware Version: 67.113
DPA 5 J2534 Drivers Version: 1.00.26
DPA Utilities: 1.21

© 2010-2013 Dearborn Group, Inc.
Permission is granted to copy any or all portions of this manual, provided that such copies are for use with the DPA product and that “© 2010-2013 Dearborn Group, Inc.”, (herein referred to as “Dearborn Group”, “DG Technologies”, or “DG”), remains on all copies.

The accompanying software, provided for use with the DPA 5, is also copyrighted. Permission is granted to copy this software for back-up purposes only.

**IMPORTANT**

To ensure your success with this product, it is essential that you read this document carefully before using the hardware. Damage caused by misuse of the hardware is not covered under product warranty.

When using this manual, please remember the following:

- This manual may be changed, in whole or in part, without notice.
- DG assumes no responsibility for any damage resulting from the use of this hardware and software.
- Specifications presented herein are provided for illustration purposes only and may not accurately represent the latest revisions of hardware, software or cabling.
- No license is granted, by implication or otherwise, for any patents or other rights of DG or of any third party.

**DPA®** and the **DG®** logo are registered trademarks of Dearborn Group, Inc. Other products that may be referenced in this manual are trademarks of their respective manufacturers.

The DPA Product line and the products supporting the DPA have been awarded the following U.S. Patents:

<table>
<thead>
<tr>
<th>Patent #</th>
<th>Date</th>
<th>Patent Overview</th>
</tr>
</thead>
<tbody>
<tr>
<td>6,772,248</td>
<td>08-03-04</td>
<td>Protocol adapter for in-vehicle networks.</td>
</tr>
<tr>
<td>7,152,133</td>
<td>12-19-06</td>
<td>Expanded functionality protocol adapter for in-vehicle networks.</td>
</tr>
<tr>
<td>7,337,245</td>
<td>02-26-08</td>
<td>Passing diagnostic messages between a vehicle network and a computer.</td>
</tr>
<tr>
<td>7,725,630</td>
<td>05-25-10</td>
<td>Passing diagnostic messages between a vehicle network and a computer using J1939 or J1708.</td>
</tr>
<tr>
<td>8,032,668</td>
<td>10-04-11</td>
<td>Passing diagnostic messages between a vehicle network and a computer using J1939 or J1708.</td>
</tr>
<tr>
<td>8,152,557</td>
<td>04-10-12</td>
<td>Positive locking mechanism for USB connected devices.</td>
</tr>
<tr>
<td>7,984,225</td>
<td>07-19-11</td>
<td>ASCII gateway to in-vehicle networks.</td>
</tr>
<tr>
<td>7,660,934</td>
<td>02-09-10</td>
<td>ASCII gateway to in-vehicle networks.</td>
</tr>
</tbody>
</table>

DG Technologies
33604 West Eight Mile Road
Farmington Hills, MI 48335
Phone (248) 888-2000
Fax (248) 888-9977
[www.dgtech.com](http://www.dgtech.com)
[sales@dgtech.com](mailto:sales@dgtech.com)
[techsupp@dgtech.com](mailto:techsupp@dgtech.com)
# Table of Contents

TABLE OF CONTENTS ................................................................................................................................................................. 3

1. SAFETY FIRST .............................................................................................................................................................................. 6

2. INTRODUCING THE DPA 5 ......................................................................................................................................................... 7

   2.1. RP1210 OEM SOFTWARE COMPATIBILITY ...................................................................................................................... 8

   2.1. J2534 OEM SOFTWARE COMPATIBILITY ...................................................................................................................... 8

   2.2. STANDARDS AND PROTOCOLS SUPPORTED .................................................................................................................. 9

   2.3. SYSTEM REQUIREMENTS .................................................................................................................................................. 11

3. EXPLAINING MULTI-APPLICATION AND SINGLE-APPLICATION DRIVERS ........................................................................... 12

   3.1. WHY TWO OEM APPLICATIONS MAY NOT WORK WHEN SHARING THE DPA ............................................................... 12

4. GETTING STARTED WITH THE DPA (STEPS 1-4 OF 6) ........................................................................................................... 13

   4.1. DRIVER INSTALLATION .................................................................................................................................................... 13

   4.2. CONNECT USB CABLE TO THE DPA AND THEN TO PC .................................................................................................... 14

   4.1. CONNECT VEHICLE-SIDE CABLE TO THE DPA ........................................................................................................... 15

   4.2. CONNECT VEHICLE-SIDE CABLE TO THE VEHICLE .................................................................................................... 15

5. FINALIZE PC INSTALL (STEP 5 OF 6) .................................................................................................................................... 16

   5.1. FINALIZE PC INSTALL ON WINDOWS 2000, XP, VISTA OR 7 32-BIT ........................................................................... 16

   5.2. FINALIZE PC INSTALL ON VISTA OR 7 64-BIT ............................................................................................................. 17

6. AUTOMATIC FIRMWARE UPDATE (STEP 6 OF 6) ..................................................................................................................... 18

7. SETTING UP YOUR RP1210-COMPLIANT OEM DIAGNOSTIC APPLICATIONS ................................................................. 19

   7.1. NOTES ON SELECTING AN RP1210 COMPLIANT ADAPTER .......................................................................................... 19

   7.2. CONFIGURING APPLICATIONS TO USE THE DPA 5 ..................................................................................................... 19

   7.3. ALLISON DOC ............................................................................................................................................................... 20

   7.4. BENDIX ABS DIAGNOSTICS ...................................................................................................................................... 20

   7.5. CATERPILLAR ELECTRONIC TECHNICIAN ..................................................................................................................... 20

   7.6. CUMMINS INSITE ........................................................................................................................................................... 20

   7.7. DETROIT DIESEL DIAGNOSTIC LINK V7 ........................................................................................................................ 21

   7.8. DETROIT DIESEL DIAGNOSTIC LINK VERSION 6.47 ...................................................................................................... 21

   7.9. DANA DIAGNOSTIC TOOL 2.X.X .................................................................................................................................. 21

   7.10. EATON SERVICE RANGER 3.X ......................................................................................................................................... 21

   7.11. FREIGHTLINER SERVICE LINK (INCLUDING CASCADIA MODEL – DUAL CAN CHANNELS) ............................................. 22

   7.12. INTERNATIONAL TRUCK AND ENGINE .................................................................................................................... 22

   7.13. MERITOR-WABCO TOOLBOX ................................................................................................................................... 23

   7.14. VOLVO/MACK VCADS PRO .................................................................................................................................... 23

   7.15. VOLVO/MACK PREMIUM TECH TOOL (PTT) .............................................................................................................. 24

8. SETTING UP YOUR J2534-COMPLIANT OEM APPLICATIONS AND DPA 5 ...................................................................... 25

9. TROUBLESHOOTING / VALIDATING YOUR DPA WITH ADAPTER VALIDATION TOOL (AVT) .................................................. 26

   9.1. CONNECTION-RELATED ISSUES ....................................................................................................................................... 26

   9.2. NOT SEEING DPA IN OEM APPLICATION VDA SELECTION LIST .................................................................................... 29

   9.3. USB-RELATED ISSUES .................................................................................................................................................... 30

   9.4. ADVANCED TESTING DIALOG ....................................................................................................................................... 30

10. J2534 - TROUBLESHOOTING YOUR DPA ............................................................................................................................ 32

    10.1. CONNECTION-RELATED ISSUES ....................................................................................................................................... 32

    10.2. USB-RELATED ISSUES .................................................................................................................................................... 34

11. DPA OPTIONS PROGRAM ...................................................................................................................................................... 35
23.6. J1939 NETWORK TESTING STEP 2 (CAN/J1939 HIGH AND CAN/J1939 LOW TO GROUND) ................................................................. 58
23.7. J1939 NETWORK TESTING STEP 3 (ROLL CALL) ..................................................................................................................... 59

24. APPENDIX H. COMMONLY REQUESTED CABLE DRAWINGS.................................................................................................. 60

24.1. DPA 4 PLUS TO DPA 4 PLUS “BACK-TO-BACK” CABLE ........................................................................................................ 60
24.2. DPA 5 TO DPA 5 “BACK-TO-BACK” CABLE ......................................................................................................................... 61
1. Safety First

It is essential that the user read this document carefully before using the hardware.

The DPA devices are to be used by those trained in the troubleshooting and diagnostics of light-duty through heavy-duty vehicles. The user is assumed to have a very good understanding of the electronic systems contained on the vehicles and the potential hazards related to working in a shop-floor environment.

DG understands that there are numerous safety hazards that cannot be foreseen, so we recommend that the user read and follow all safety messages in this manual, on all of your shop equipment, from your vehicle manuals, as well as internal shop documents and operating procedures.

- Always block drive, steer, and trailer wheels both front and back when testing.
- Use extreme caution when working around electricity. When diagnosing any vehicle, there is the risk of electric shock both from battery-level voltage, vehicle voltages, and from building voltage.
- Do not smoke or allow sparks or open flames near any part of the vehicle fueling system or vehicle batteries.
- Always work in an adequately ventilated area, and route vehicle exhaust outdoors.
- Do not use this product in an environment where fuel, fuel vapor, exhaust fumes, or other potentially hazardous liquids, solids, or gas/vapors could collect and/or possibly ignite, such as in an unventilated area or other confined space, including below-ground areas.
2. Introducing the DPA 5

The DPA 5 products are used to connect vehicle and equipment communication networks to personal computers (PCs). This allows programs written for the PC to retrieve pertinent information such as fault codes, component information, as well as perform component level diagnostics, tests, and component reprogramming. The DPA 5 communicates with the PC using either a USB cable or via Bluetooth (Class I or Class II), and comes standard with Technology and Maintenance Council (TMC) Recommended Practice (RP) RP1210C-compliant drivers, as well as Society of Automotive Engineers (SAE) J2534-compliant drivers.

The DPA 5 Dual-CAN / Bluetooth device is the most commonly sold DG DPA 5 product. This manual is geared more to this product; however, the concepts also apply to the DPA 5 Quad-CAN. Distinctions will be made as appropriate.

Before switching communications modes from USB to Bluetooth and vice-versa, the DPA 5 Dual-CAN / Bluetooth must be powered off and then back on.
2.1. RP1210 OEM Software Compatibility

The adapter you have purchased is provided with a Technology and Maintenance Council (TMC) RP1210C compliant (backwards compatible with RP1210B and RP1210A) interface and has been validated against the following OEM and component applications:

- Allison DOC™
- Bendix® ACOM
- Caterpillar® Electronic Technician
- Cummins® Insite™
- Cummins PowerSpec™
- Dana Diagnostic Tool™
- Detroit Diesel Diagnostic Link™
- Detroit Diesel Reprogramming Station™
- Eaton ServiceRanger
- Freightliner ServiceLink
- International® Diamond Logic Builder
- International® InTune
- International® Master Diagnostics
- International® ServiceMaxx
- Mack and Volvo VCADS/PTT
- Meritor-WABCO Toolbox
- Vansco VMMS
- ZF-Meritor TransSoft

Any application claiming RP1210A, RP1210B, or RP1210C compliance should work if the application and adapter both support the same protocol(s) and operating system(s).

2.1. J2534 OEM Software Compatibility

The adapter you have purchased is provided with an SAE J2534-compliant interface (an SAE standard for electronic module reprogramming – sometimes call the “Pass Thru Programming” standard). The DPA 5 should be able to reprogram all CAN/ISO15765 vehicles, GM vehicles using the J1850 Variable Pulse Width (VPW) protocol, or other vehicles using the DPA 5 J2534-supported protocols (i.e. ISO9141/KWP2000).

The DPA 5 has been validated against the following OEM and component applications:

- General Motors TIS2Web
- Ford Module Programming (FMP)
- Chrysler J2534 Application
- Toyota TIS (Technical Information System)
- Honda Service Express
- Mazda Module Programming (MMP)
- Kia J2534 KMA
- Hyundai 2534 HMA
- Volkswagen Erwin
- Audi Erwin
- Nissan J2534 ECU Reprogramming Software (NERS)

All J2534 reprogramming and diagnostic software packages that are J2534-1 and J2534-2 compliant and use a protocol supported by the DPA 5 should work as long as the operating system is supported by the application. Note that not all OEMs have released J2534-2 compliant software.
2.2. Standards and Protocols Supported

The adapter you have purchased provides more protocol and standards support than any other commercially available diagnostic adapter.

2.2.1. Operating Systems and Standards Supported

- **Operating Systems**
  - Windows 2000®
  - Windows XP®
  - Windows Vista® 32-bit and 64-bit Versions
  - Windows 7® 32-bit and 64-bit Versions
- TMC RP1210C, RP1210B, TMC RP1210A
- SAE J2534-1, J2534-2
- CE Certification
- Vehicle Electronic Programming Station (VEPS) J2214/J2461

2.2.2. RP1210 Defined Protocols Supported

- **J1939**
  - J1939@250k – Standard J1939
  - J1939@500k – Per J1939/14
  - Automatic Baud Rate Detection Capable
- **CAN (ISO11898)**
  - Automatic Baud Rate Detection Capable
- **CAN@500k/J2284/GMLAN**
  - The IESCAN protocol name is also CAN@500k.
  - Automatic Baud Rate Detection Capable
- **J1708/J1587**
- **J1850 GM (Class 2)**
  - The following protocol names are supported: J1850, J1850_416K, J1850_104K. The send and read message format was changed from RP1210A to RP1210B for this protocol. We support both formats. The J1850 protocol name indicates the RP1210A format for sending and reading data. The J1850_416K, J1850_104K names indicate the RP1210B format.
- **ISO 9141-2**
- **ISO 14230 (KWP2000)**
2.2.3. **RP1210_ClientConnect() Modifiers Supported (CAN Automatic Baud Rate Detection, Channel)**

The DPA 5 supports automatic CAN baud rate detection as required by RP1210C in preparation for J1939 moving from a speed of 250k to 500k. To support this, the DPA 5 API supports this through an application issuing a modifier to the RP1210_ClientConnect() function call (for any CAN protocol):

- RP1210_ClientConnect( "J1939:Baud=Auto"")
- RP1210_ClientConnect( "CAN:Baud=Auto"")
- RP1210_ClientConnect( "ISO15765:Baud=Auto"")
- RP1210_ClientConnect( "J2284:Baud=Auto"")

If the application wants to know what speed they connected at, they can issue the command:

- RP1210_SendCommand(RP1210_Get_Protocol_Connection_Speed)

The DPA 5 supports 2 (Dual CAN) or 4 (Quad CAN) CAN (J1939/ISO15765/J2284) channels. To access these channels, the DPA 5 API supports this through an application issuing a modifier to the RP1210_ClientConnect() function call:

- RP1210_ClientConnect( "J1939:Channel=X"")

These two modifiers can be combined. For example, “J1939:Baud=Auto;Channel=2”.

2.2.4. **J2534 Defined Protocols Supported**

- CAN (Raw CAN)
- J1850 VPW (GM Class II)
- ISO 15765-4
- GMLAN (HSCAN, SWCAN)
- ISO 14230 (KWP2000)
- ISO 9141-2
- J1708/J1587
- J1939

2.2.5. **Additional Protocols Supported by Native Drivers**

- J2411 (GM SWCAN)
- ALDL
2.3. System Requirements

If you are not familiar with selecting a PC for your diagnostic applications, we recommend starting with a computer compatible with the latest version of the TMC RP1208 (PC Selection Guidelines for Service Tool Applications).

In addition to the aforementioned document, the following items are recommended or required.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC</td>
<td>IBM-Compatible</td>
</tr>
<tr>
<td>Processor</td>
<td>1GHz or Faster</td>
</tr>
<tr>
<td>RAM</td>
<td>256MB (512MB Preferred)</td>
</tr>
<tr>
<td>USB Port</td>
<td>USB Version 1.1 or Higher</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 2000</td>
</tr>
<tr>
<td></td>
<td>Windows XP</td>
</tr>
<tr>
<td></td>
<td>Windows Vista (32-bit or 64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows 7 (32-bit or 64-bit)</td>
</tr>
</tbody>
</table>
3. Explaining Multi-Application and Single-Application Drivers

This release of the DPA drivers supports multiple applications running simultaneously (i.e. sharing the DPA) through the DGDPA5MA drivers. For example, there may be a time where you need to run an engine and transmission application at the same time or there may be a need to run a data logging application alongside your engine diagnostics. It has been DG’s experience that when several OEM applications are running simultaneously, especially on a crowded J1939 data bus, they sometimes miss critical timing events and messages and do not behave as they would normally.

3.1. Why Two OEM Applications May Not Work when Sharing the DPA

Running two or more OEM applications that were not designed to share an adapter in a situation where they are in fact sharing the adapter is a hit-or-miss scenario. They might work well together and they may not. The two big reasons some work well together and others don’t is J1939 addressing and timing related.

3.1.1. J1939 Addressing Issues

Per SAE J1939, every ECM or application using a VDA must go through a process to claim a J1939 address. According to J1939, before an ECM or application can send or receive long messages (greater than the standard 8-byte CAN messages); an address must be claimed. These long messages are sent using what is called the J1939 Transport Protocol (TP). Long messages are used for data such as make, model, serial number, VIN, and for reprogramming and calibration (very common in OEM diagnostic applications).

The past RP1210 specifications (RP1210-0, RP1210A, and RP1210B) implied that a Vehicle Diagnostic Adapter (VDA) should have only 1 J1939 address. This means the VDA will handshake for TP messages to/from 1 specific J1939 address. This meant that if one application claims 249 and another application connected while sharing the VDA (i.e. Multi-Application mode) and claimed address 250; one address will get dropped. This means that only one of those applications will be capable of sending and receiving long TP messages. If the application that had its address get dropped depends on these long TP messages, it may not behave properly.

Another problem is that some OEM applications don’t handle the RP1210 return value "ERR_ADDRESS_LOST" when they lose their claimed J1939 address. The application may keep running oblivious to the fact they are not going to get any long messages; no matter how many times they request them.

The DPA 5 multi-application (MA) drivers behave in a semi-shared-addressing scenario. If the first application claims an address like 249, and the second application claims 249, then both apps will get TP messages destined for 249. If the second application were to claim 250, it would be denied.

3.1.2. Timing Related Issues

The second most common reason that two OEM applications don't work well together is timing. OEM applications expect to send a message out and read a response back from a controller in “X” amount of time. When two or more applications are sharing the VDA, messages are stacked for sending in some sort of a transmit buffer and received messages are also stacked in a receive buffer (commonly called a queue). When you stack message requests and responses, this slows down the send/receive process and many applications timeout because of it. The more applications sharing the VDA, the more potential there is for a delay or timeout scenario.

3.1.3. OEM Applications are NOT Tested in a Shared VDA Scenario

NO OEM APPLICATIONS CLAIM TO BE MULTI-APPLICATION CAPABLE!

None of them test with another OEM application running. They assume that they are the only application running on that PC through the VDA they are using.

This is why if you want to run multiple apps at the same time, some apps have to be started first before the second application. Sometimes, they just won't work no matter what you do!
4. Getting Started with the DPA (Steps 1-4 of 6)

If you ordered the DPA 5 as part of a kit, it should include the following items:

- Rugged Plastic Carrying Case
- DPA 5 Diagnostic Tool
- 6-pin/9-pin Deutsch Connector “Y” Cable, for vehicle-side connection
  - The cable supports two CAN channels (configured for the Freightliner Cascadia)
- USB Cable, gold-plated with screw-in ears to secure the cable to the DPA 5 case
- DPA 5 Installation Disc
- Printed Quick Start Sheet
- Bluetooth PC dongle (if a Bluetooth kit was purchased)

Please note that DG Technologies does customize our kits for our vendors, so what you receive may vary.

4.1. Driver Installation

Attention!

- Install DPA drivers from CD before connecting DPA to your PC.
- To install drivers you must be logged into the administrator account or have administrator privileges.
- If you run into problems installing the drivers or the DPA, please do not hesitate to contact technical support at (248) 888-2000.

Attention!

The DPA drivers provided on the installation CD are installed by inserting the disc into your PC’s CD-ROM drive. The latest drivers and firmware are always available at www.dgtech.com/download.php. If you have any questions about the install, please contact our technical support staff.

If setup does not begin automatically, use the following sequence for Windows 2000 and XP:

Start ➔ Run ➔ [CD_Drive_Letter]:\DPA5Install.exe and click OK
If setup does not begin automatically, use the following sequence for Windows Vista or Windows 7:

Start ➔ All Programs ➔ Accessories ➔ Run ➔ [CD_Drive_Letter]:\DPA5Install.exe and click OK

After the drivers are installed, you will be prompted to restart your computer. While your PC is rebooting, continue following the next instructions.

4.2. Connect USB Cable to the DPA and Then to PC

Remove the sticker covering the USB port and connect the USB cable to the DPA and PC. The USB cable that comes with the DPA 5 has ears that allow the cable to be screwed into standoff screws on the DPA 5 frame, greatly reducing the chance of breaking the USB connector on the DPA circuit board.
4.1. Connect Vehicle-Side Cable to the DPA

**WARNING!**

Connect the vehicle-side cable to your DPA. Do not connect to vehicle first! Pins 6 and 8 on the DB25 connector are power and ground and can arc if not careful!

Vehicle-Side 6-pin/9-pin Deutsch “Y” Cable (Heavy-Duty)

4.2. Connect Vehicle-Side Cable to the Vehicle

Now, connect the DPA to the vehicle, verifying that the DPA **Power** LED is lit.
5. Finalize PC Install (Step 5 of 6)

This step differs depending on which version of Microsoft Windows you are installing on.

5.1. Finalize PC Install on Windows 2000, XP, Vista or 7 32-bit

If you are installing on either Vista or Windows 7 64-bit, go to section 5.2 Finalize PC Install on Vista or 7 64-bit.

The DPA is now connected to the PC and powered on. In some versions of Windows the final step in driver installation is automatic. In others, the Windows Found New Hardware Wizard will run to finalize driver installation. What appears in Windows XP is shown below.

Select **Install the software automatically (Recommended)** and press the **Next** button.

This screen appears while Windows installs the drivers.

This screen appears when Windows has finished installing the drivers. Press the **Finish** button. Your DPA drivers have been installed successfully.
5.2. Finalize PC Install on Vista or 7 64-bit

5.2.1. 64-bit Vista and Windows 7 installed successfully

After installing on Vista or Windows 7, simply plug the DPA 5 into the PC via the USB cable. The DPA 5 is powered on. The following screen will display in the lower right corner for about five seconds.

Followed by this screen. Your DPA 5 is now ready for use.
6. **Automatic Firmware Update (Step 6 of 6)**

When a DPA PC drivers release is made, a specific set of DPA firmware is validated with that release. In this release the firmware that was validated can be found on the cover page of this manual.

**DG strongly recommends that users keep their DPA up-to-date with the latest firmware revision.**

*Automatic Firmware Update* is an option that is most likely turned *On* in your installation. Some customers receive special drivers where this is not the case, however this paragraph assumes that this option is turned on, and set to a value of 1. To learn more about this option, see the chapter entitled *Modifying DPA Settings – DPA Options Program*.

After you have finished installing the Windows device drivers (Step 5 of 6) you can begin using your DPA. If the *Automatic Firmware Update* option is on (by default, it is), every time you connect to the DPA, the drivers check to see if a newer version of firmware is available on the hard drive. If a newer version is available the user will be prompted (see Figure 6.1) to upgrade to that version. If the user selects *Yes*, the upgrade process begins automatically. When the upgrade process is complete, the connect sequence for that application will continue. Most applications can handle the delay; however there is a possibility that the user may have to restart their application.

The following is the dialog box that will be displayed if out-of-date firmware is detected. We recommend pressing *Yes* and upgrading.

![DPA Firmware Requires Updating](image)

*Figure 6.1. DPA Firmware Out of Date Dialog Box*
7. Setting Up Your RP1210-Compliant OEM Diagnostic Applications

The DPA works with all RP1210A, RP1210B, and RP1210C compliant applications that support J1708/J1587, CAN/J1939, J1850 VPW (GM Class II) and the ISO15765 protocols. The DPA also works with applications that were specifically written to use the DG non-RP1210-compliant native drivers for other protocols, such as GM UART and ISO9141. This section shows how to configure the most common RP1210-compliant diagnostic applications to work with the DPA 5.

7.1. Notes on Selecting an RP1210 Compliant Adapter

Selecting a RP1210 adapter, commonly referred to as a Vehicle Datalink Adapter (VDA) varies widely from application to application; however, the terminology remains pretty much the same. The following table helps to introduce you to the terminology and helps you to make the correct selections the first time.

You must set up every application (in their own individual way) to use the DPA!
Not all OEM applications save the adapter configuration! Some make the user select the adapter to be used every time the application is opened.

<table>
<thead>
<tr>
<th>If You See These Terms</th>
<th>Select This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor APIs</td>
<td>Dearborn Group DPA 5 Multiple Application</td>
</tr>
<tr>
<td>Manufacturer DLLs</td>
<td>Or</td>
</tr>
<tr>
<td>Adapter Manufacturer</td>
<td>DGDPA5MA</td>
</tr>
<tr>
<td>Device Name</td>
<td>DG DPA 5 Dual-CAN (MA) USB, USB</td>
</tr>
<tr>
<td>Adapter Name</td>
<td>Or</td>
</tr>
<tr>
<td></td>
<td>DPA 5 #[DPA 5 Bluetooth ID] (MA) Bluetooth, Wireless</td>
</tr>
<tr>
<td>Device Number</td>
<td>1</td>
</tr>
<tr>
<td>DeviceID</td>
<td>Or</td>
</tr>
<tr>
<td>Bluetooth Wireless DeviceID</td>
<td>Bluetooth Wireless DeviceID</td>
</tr>
<tr>
<td>Protocol (Depends on Application)</td>
<td>Most Commonly Encountered:</td>
</tr>
<tr>
<td></td>
<td>✓ J1708 (J1708/J1587)</td>
</tr>
<tr>
<td></td>
<td>✓ J1939</td>
</tr>
<tr>
<td></td>
<td>✓ ISO15765</td>
</tr>
<tr>
<td></td>
<td>✓ CAN</td>
</tr>
</tbody>
</table>

7.2. Configuring Applications to Use the DPA 5

The following examples show how to select your DPA 5 device using the USB cabling method. Bluetooth device entries are based on the DPA 5 Bluetooth ID (see Bluetooth appendix).
7.3. Allison DOC

1. Start program.
2. Click **Connect to Vehicle**.
3. Select the Correct Transmission Type.
4. Uncheck **Smart Connect**.
5. Click **Connect**.
6. Click **Advanced Setup**.
7. Select vendor of **Dearborn Group DPA 5 Multiple Application**.
8. Select protocol of **J1939** or **J1708**.
9. Select correct device of **DPA 5 Dual CAN USB** (or **DPA 5 #[DPA 5 Bluetooth ID] Bluetooth**).
10. Click **OK**.

7.4. Bendix ABS Diagnostics

**NOTE:** DO NOT RUN Bendix ABS Diagnostics until you have done the following:

1. Start program.
2. If **Diagnostic Interface Selection** dialog box does not appear, click on **Vehicle Interface Adapter** icon.
   a. Select **RP1210A Device Using J1708 Line: DPA 5 Dual CAN USB** (or **DPA 5 #[DPA 5 Bluetooth ID] Bluetooth**).
3. Click **OK**.

7.5. Caterpillar Electronic Technician

1. Start Program.
2. Click **Utilities → Preferences → Communications** from the menu bar.
3. Click on **Communication Interface Device** dropdown box.
4. Select **RP1210 Compliant Device**.
5. Click **Advanced**
6. Select **DPA 5 Dual CAN USB** (or **DPA 5 #[DPA 5 Bluetooth ID] Bluetooth**) in the RP1210 Communication Adapter Device box.
7. Click **OK**
8. Check **Enable Dual Data Link Service**
9. Click **OK**.

7.6. Cummins Insite

1. Start Program.
2. Click on **File → Connections → Add New Connection**.
3. Click **Next**.
4. Click radio button for **Datalink Adapter** and click **Next**.
5. Select correct device **DPA 5 Dual CAN USB** (or **DPA 5 #[DPA 5 Bluetooth ID] Bluetooth**), and protocol you want to use, **J1708/J1939**.
6. Click **Next** and a Connection Name screen appears.
7. Click **Next** and a screen prompts you to indicate whether you want to make this connection active or set up another connection.
8. Click on **make this connection active**.
9. Click **Finish**.
7.7. Detroit Diesel Diagnostic Link V7

7.7.1. From Windows Start Menu

1. Start ➔ Programs ➔ Detroit Diesel ➔ Diagnostic Link ➔ SID configure
2. Select DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).
3. Click OK.

7.7.2. From Inside DDDL

1. Tools ➔ Options ➔ Connections Tab ➔ SID Configure.
2. Select DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).
3. Click OK.

7.8. Detroit Diesel Diagnostic Link Version 6.47

There are two ways to open v6.47, depending on your installation.

A. If you have the Detroit Diesel Electronic Tool Suite on your desktop:

1. Select Detroit Diesel Electronic Tool Suite icon from desktop.
2. Select Configure button.
3. Select DG DPA 5 Dual-CAN (MA) USB, USB, select OK button.
4. Select Refresh button.
5. Click on highlighted DDDL 6 item.
6. Select Look at active and inactive faults.

B. If you have the Diagnostic Link icon on your desktop:

1. Select Diagnostic Link icon from desktop.
2. Select Look at active and inactive faults.
3. To change the adapter, select Tools | Options | Interface
4. Select DG DPA 5 Dual-CAN (MA) USB, USB from Local Communication Interface drop-down list.
5. Select OK button.

7.9. Dana Diagnostic Tool 2.x.x

1. Start program
3. Select Connect J1708 or Connect J1939 or Connect PLC as appropriate for your controller.

7.10. Eaton ServiceRanger 3.x

1. Start Program
2. Click Tools ➔ Settings ➔ Connection.
3. Under Driver choose Dearborn Group DPA 5 Multiple Application
4. Select DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth) for both the J1708 and J1939 device.
5. Click OK.
7.11. Freightliner ServiceLink (Including Cascadia Model – Dual CAN Channels)

1. Start program.
2. From the top menu bar, choose Admin.
3. Click on Show All Devices.
4. Vendor = Dearborn Group DPA 5 Multiple Application
5. J1708 Device = DG DPA 5 Dual-CAN (MA) USB, USB
6. J1939 Device = DG DPA 5 Dual-CAN (MA) USB, USB
7. CAN Device
   a. Click Configure
   b. Select DG DPA 5 Dual-CAN (MA) USB, USB
8. Click Save Settings.

7.12. International Truck and Engine

7.12.1. Master Diagnostics (MD Fleet)

1. Start program.
2. Choose File ➔ MD Settings ➔ COM Device ➔ Window with general VDA selection
3. Select Dearborn Group DPA 5 Multiple Application ➔ Window with specific port DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).

7.12.2. Navistar Hydraulic ABS

1. Start program.
2. Choose File ➔ Hydraulic ABS Settings ➔ COM Device ➔ Window with general VDA selection
3. Select Dearborn Group DPA 5 Multiple Application ➔ Window with specific port DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).

7.12.3. Navistar IPC

1. Start program.
2. Choose File ➔ Settings ➔ COM Device ➔ Window with general VDA selection
3. Select Dearborn Group DPA 5 Multiple Application ➔ Window with specific port DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).

7.12.4. Diamond Logic Builder (DLB)

1. Start program.
2. Choose Tools ➔ Select Com Link ➔ Listing of adapters
3. Select Dearborn Group DPA 5 Multiple Application ➔ Listing of ports DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).

7.12.5. Service Assistant (The new MD Fleet)

1. Start program.
2. Press third button from the top along the left side (has an icon that looks like a miniature interface cable.)
   a. A window comes up that says Communication Device Selection and has two drop down boxes.
   b. Select Dearborn Group DPA 5 Multiple Application ➔ DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).
7.12.6. ServiceMaxx:

1. Select ServiceMaxx icon from desktop
2. Enter username and password (if required)
3. Select Tools ➔ Select COM Link ➔ Dearborn Group DPA 5 Multiple Application ➔ DG DPA 5 Dual-CAN (MA) USB, USB ➔ select J1708 or J1939 depending on engine type.
4. "Searching for Engine" appears
5. Select engine type when prompted and click OK button.

7.13. Meritor-WABCO Toolbox

1. Start Program.
2. Click System Setup; then select COM Port.
3. Select Dearborn Group DPA 5 Multiple Application; the protocol to use is J1939 or J1708.
4. Select DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth) and click OK.

7.14. Volvo/Mack VCADS Pro

7.14.1. From Initial VCADS Setup

1. When prompted to configure a Communication Unit select RP1210A adapter.
2. When prompted for the adapter, select DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).
3. Select USB for the Port.
4. Select J1708 for the protocol.
5. When prompted for the Electrical Systems.
   a. Click Volvo Trucks – VERSION2 and select RP1210A Adapter
   b. Click Volvo Trucks – Vehicle electronics ’98 and select RP1210A Adapter
   c. Click Mack Trucks – V-MAC I/II/III, ITC and select RP1210A Adapter
   d. Click Volvo Trucks – V-MAC IV and select RP1210A Adapter
6. Continue with installation.

7.14.2. From Inside VCADS

1. Start Program.
2. Click the Tools menu and choose Options.
4. Select RP1210A Adapter and then select DPA 5 Dual CAN USB (or DPA 5 #[DPA 5 Bluetooth ID] Bluetooth).
5. Select USB for the Port.
6. Select J1708 for the protocol.
7. Go to the Comm. Unit Selection tab.
   a. Click Volvo Trucks – VERSION2 and select RP1210A Adapter
   b. Click Volvo Trucks – Vehicle electronics ’98 and select RP1210A Adapter
   c. Click Mack Trucks – V-MAC I/II/III, ITC and select RP1210A Adapter
   d. Click Volvo Trucks – V-MAC IV and select RP1210A Adapter
8. Click Ok.
7.15. **Volvo/Mack Premium Tech Tool (PTT)**

1. Start Program.
2. Select Settings from the PTT menu.
3. Go to the Communication Unit configuration tab:
   a. It is here that you select the settings for each adapter that you may use. For example, if you have an RP1210A adapter, it is here that you select which adapter, port, and protocol.
   b. **NOTE:** This identifies the settings for each adapter. It does not select which adapter the PTT application will use to communicate with the vehicle.
4. Go to the Comm unit selection tab:
   a. It is here that you identify which adapter is to be used by the PTT application to communicate with the vehicle. You may have to change this selection depending upon the vehicle.
   b. For example, if you typically use an 88890020 adapter in direct mode, when you need to communicate with an older vehicle you will need to change to RP1210A adapter or the 9998555 adapters, depending upon the vehicle.
8. Setting Up Your J2534-Compliant OEM Applications and DPA 5

Setting up and reflashing of a component using a J2534-compliant OEM application is a very lengthy process and is out of the scope of this manual. For more information, you can refer to the OEM application documentation or you can download the OEM application reflashing guide from the Dearborn Group VSI-2534 device downloads page.

In general, there will be a screen that will appear at some point that allows a user to select a J2534-compliant Vendor and Device for the reflashing event. When you see this type of screen, choose Dearborn Group, Inc. and/or the DPA 5.

The General Motors TIS2Web - J2534 Application VDA selection screen.
9. Troubleshooting / Validating Your DPA with Adapter Validation Tool (AVT)

If your OEM diagnostic application is having trouble using the DPA after following the instructions for configuring that application, you can use the DG Adapter Validation Tool (AVT) to troubleshoot the DPA and validate that the DPA drivers are installed properly, the PC can communicate with the DPA, and the DPA can see message traffic on the data bus that your OEM diagnostic application is trying to use.

- Most DPA technical support calls about OEM applications not working come from users who have not configured that OEM application to use the DPA, or who have selected the incorrect protocol.
  - The quick rule of thumb for selecting a protocol is the type of connector you are connecting to:
    - J1708 Connector (6-pin Deutsch)
      - This connector only has the J1708/J1587 protocol.
    - J1939 Connector (9-pin Deutsch)
      - OEMs switched to this connector when they moved to J1939. J1708 may not be available.

There are typically three problem areas with RP1210 VDA devices. Each problem is discussed in the following sections:

9.1. Connection-Related Issues

After you have followed the instructions in this manual to install the DPA drivers, connect the DPA to the vehicle and ensure the Power LED is on. Then connect it to the PC and listen for the familiar da-ting “USB device found” sound. If you cannot hear this sound, the PC cannot communicate with the DPA and you will most likely end up not being able to get AVT to be successful. Try another USB port until you hear that sound.

Run AVT either from the Adapter Validation Tool link on your desktop, or from the Start Programs menu.

Start ➔ Programs ➔ Dearborn Group Products ➔ DPA 5 ➔ Adapter Validation Tool
Select the DPA 5 Dual-CAN / Bluetooth device (or DPA 5 Quad-CAN):

- **Vendor**: DGDP5MA - Dearborn Group DPA 5 Multiple Application
- **Device**: 1 – DG DPA 5 Dual-CAN USB – USB
  2 – DG DPA 5 Quad-CAN USB – USB
- **Protocol**: J1708 or J1939 (depending on your application)

Then click the Run Test button. Depending on the results of the test, both the RP1210 Status Window and RP1210 Data Message Window will turn green (pass) or red (fail).

### 9.1.1. AVT Test Outcomes

If the RP1210 Status Window turns red, then there is a problem causing the PC not to communicate with the DPA. This may be something as simple as having power to the DPA or a USB issue. Disconnect the DPA from the vehicle and PC; then reconnect them, this time connecting to another USB port on the PC.

If the RP1210 Status Window turns green and the RP1210 Data Message Window turns red, then the PC is seeing the DPA, but not seeing messages from the data bus. Check the vehicle ignition switch and vehicle to adapter cabling. Disconnect the DPA from the vehicle and PC; then reconnect them.

*If you see data in the RP1210 Data Message Window, your DPA is installed and functioning properly! Refer to the chapter on how to configure your OEM application to use the DPA.*

Read the Test Results Discussion and Next Steps screen carefully and follow those directions to help diagnose where the issue may be. If, after reading and following those instructions, you cannot get the DPA working, please contact DG technical support.

- Many DPA technical support calls could have been avoided by following the instructions on the Test Results Discussion and Next Steps screen.

### 9.1.2. Good Connection (PC to DPA), Good Read of Data (DPA to Vehicle) – Green/Green

The above screen snapshots show the PC successfully connecting to the DPA (RP1210 Status Window) and the successful reading of data bus data (RP1210 Data Message Window) from the J1939 data bus.

- A Green/Green result indicates the DPA is working perfectly and is seeing data on the data bus. The area to work on is configuring the OEM application to use the DPA (see Chapter 7).
9.1.3. Good Connection (PC to DPA), Not Able To Read Data (DPA to Vehicle) – Green/Red

The above screen snapshots show the PC successfully connecting to the DPA (RP1210 Status Window) but AVT is not able to read data bus data (RP1210 Data Message Window) from the data bus selected (J1939).

- A Green/Red result indicates the DPA is working perfectly, but it is not seeing data on the data bus that was selected. Choose another protocol and check that the ignition switch is on.

9.1.4. Bad Connection (PC to DPA), Not Able To Read Data (DPA to Vehicle) – Red/Red

The above screen snapshots show the PC not connecting to the DPA (RP1210 Status Window).

- A Red/Red result indicates the PC is not seeing the DPA. Unplug DPA from vehicle and PC and reconnect to both using a different USB port. Ensure that you hear the da-ding “USB Device Found” sound. If you cannot hear the sound, reboot the PC and run AVT again. DG has been getting a lot of DPA technical support calls where OEM applications crash and keep the DPA device open.
9.2. Not Seeing DPA in OEM Application VDA Selection List

If you have installed the DPA drivers and can get AVT to a Green/Green outcome, you should be able to configure your diagnostic application to use the DPA. If your diagnostic application does not display **DG DPA 5 Dual-CAN, USB** in their VDA selection dialog box, this could indicate one of three things:

1. The application is not RP1210 compliant and does not work with the DPA.
   a. Some applications require a specific, proprietary adapter.

2. Application is RP1210 compliant, but DPA does not support the protocol needed.

3. Problem with the main RP121032 INI file.
   a. Some VDAs create issues with the RP121032 INI file when they install/uninstall.
   b. Many OEM diagnostic applications are aware of this issue and can read through the errors.

When the AVT software is launched, you will be told if a problem exists in the main RP121032 INI file. If you wish to fix this issue (very highly recommended), press the **Fix/Change RP121032.INI File** button on the main screen. If your PC is running Windows Vista or Windows 7, you will be prompted for administrator privileges. The following is the dialog box that will appear when AVT is launched and a problem is found in the main RP121032 INI file.

When you press the **Fix/Change RP121032.INI File** button, AVT will bring up a separate program called **Fix INI** that will allow you to view and fix the RP121032 INI file if there are errors detected. You can also change the VDA that appears first in the list of the OEM diagnostic software applications.

In the example below, a bad INI file was detected (depicted by a yellow background). Note the multiple commas and spaces between entries.

Click the **Make Changes** button and the INI file problem will be corrected. If you wish to make a specific adapter first in the list, you can select that vendor in the **Vendor to Make First in List** before pressing the **Make Changes** button.
The next picture shows the dialog box indicating that the INI file was fixed.

![Dialog box showing INI file fixed](image)

9.3. **USB-Related Issues**

If you plug in a DPA (or any other USB device) and get the New Hardware Found wizard, do not click cancel. Go through the wizard completely! **IF YOU SELECT Cancel, THE DPA WILL NOT WORK!**

Windows has many USB eccentricities that are generally solved by unplugging a device and then plugging that device back in. Sometimes you have to plug that device into another USB port.

9.4. **Advanced Testing Dialog**

With the J1939 data bus moving to 500k, there is a lot of RP1210 and J1939 committee focus on VDA vendors doing J1939 automatic baud detection to detect either a 250k or 500k J1939 data bus without creating issues. There is also a growing need for advanced testing on vehicles that have a second CAN data bus.

The DPA 5 API Supports the following commonly used RP1210_ClientConnect() modifications:

- Protocol:Baud=Auto
- Protocol:Baud=XXX
- Protocol:Channel=X
- Protocol:Baud=Auto;Channel=X
- Protocol:Baud=XXX;Channel=X

Pressing the **Advanced Test** button brings up the dialog box shown below.

![Advanced Test dialog box](image)
9.4.1. Vendor, Device, Protocol

**Vendor**, **Device** and **Protocol** fields are the same as described in normal testing above.

9.4.2. Baud Rate Drop Down List Box

The **Baud Rate** drop down list box allows the user to select one of the supported protocol speeds for the selected protocol. The entries in this list box come from the VDA vendor’s INI file. Click the **Use Baud Rate** checkbox to activate a “Protocol:Baud=XXX” connection. If both the **Use Baud Rate** and **Use Channel** checkboxes are checked, then AVT will initiate a “Protocol:Baud=XXX;Channel=X” connection.

9.4.3. Channel Drop Down List Box

The **Channel** drop down list box allows the user to select one of the supported channels for the selected device. The entries in this list box come from the VDA vendor’s INI file. Click the **Use Channel** checkbox to activate a “Protocol:Channel=X” connection. If both the **Use Baud Rate** and **Use Channel** checkboxes are checked, then AVT will initiate a “Protocol:Baud=XXX;Channel=X” connection.

9.4.4. Vendor Supports CAN Auto Baud Checkbox

This checkbox indicates whether or not the API supports CAN (CAN, J1939, ISO15765) automatic baud detection. Even though this variable may be set to TRUE, the next four fields indicate whether the API supports Baud=XXX connect formats for CAN, J1939, and ISO15765. This field is just an informational field, and not all VDA vendors will support this feature.

9.4.5. Protocols Supporting Baud=XXX

These checkboxes indicate whether or not the API supports setting a specific baud rate (or automatic baud detection) for a specific protocol. These entries come from the VDA vendor’s INI file. These fields are just for informational purposes. Not all VDA vendors will support this feature.

9.4.6. Advanced Testing Commands – No Error Checking

When using this dialog box to initiate an advanced test, there is no error checking done to prevent the user from initiating a “Baud=XXX” or “Channel=X” connection to a VDA even if the vendor does not support that connection format.
10. J2534 - Troubleshooting Your DPA

There are typically three problem areas with J2534 VDA devices. Each problem is discussed in following sections:

10.1. Connection-Related Issues

After you have installed the DPA drivers and connected the DPA to both the PC and vehicle, make sure that the DPA Power LED is turned on. Run the J2534 Adapter Validation Tool (JVT) to ensure that the PC is able to communicate with the DPA, and that the DPA is able to see vehicle data bus traffic.

Start ➔ Programs ➔ Dearborn Group Products ➔ DPA 5 J2534 ➔ J2534 Validation Tool

Select the correct Device:
- Device: DPA 5 – Dearborn Group, Inc.
- Protocol: OBDII or Specific Protocol
  - Using the OBD II protocol selection means that JVT will attempt to connect using all OBD II protocols that the selected adapter supports (i.e. J1850VPW, ISO9141, ISO14230, ISO15765, etc) and with all OBD II options and OBD II speeds for that protocol (i.e. CAN 1Mb 11-bit, CAN 1Mb 29-bit, CAN 500Kb 11-bit, CAN 500Kb 29-bit, etc). DG recommends using the OBDII protocol setting initially since all vehicles after 1996 have to support an OBD II protocol.
  - You can also use a specific protocol (i.e. “CAN” as above), and JVT will connect using all speeds and options for that individual protocol.

Then click the Run Test button. Depending on the results of the test, both the J2534 Status Window and J2534 Data Message Window will turn green (pass) or red (fail).

10.1.1. JVT Test Outcomes

If the J2534 Status Window turns red, then there is a problem causing the PC not to communicate with the adapter. This may be something as simple as having power to the adapter or having a USB cabling issue. Disconnect the adapter from the vehicle and PC; then reconnect them, this time connecting to another USB port on the PC.

If the J2534 Status Window turns green and the J2534 Data Message Window turns red, then the PC is seeing the adapter, but not seeing messages from the vehicle. Check the vehicle ignition switch and vehicle to adapter cabling; disconnect the adapter from the vehicle and PC; then reconnect them.
If you see data in the **J2534 Data Message Window**, then the adapter is installed and functioning properly.

If after following the **Test Results Discussion and Next Steps** screen, you cannot get the adapter to read data, contact DG technical support.

### 10.1.2. Good Connection (PC to DPA), Good Read of Data (DPA to Vehicle) – Green/Green

The above screen snapshots show the PC successfully connecting to the DPA and the successful reading of data bus data from the CAN data bus. Once the test is complete, the application will display an informational screen (image on the right) listing steps to potentially correct the issue.

### 10.1.3. Good Connection (PC to DPA), Not Able To Read Data (DPA to Vehicle) – Green/Red

The above screen snapshots show the PC successfully connecting to the DPA but the application is not able to read data bus data from the data bus selected (CAN). Once the test is complete, the application will display an informational screen (image on the right) listing steps to potentially correct the issue.
10.1.4. **Bad Connection (PC to DPA), Not Able To Read Data (DPA to Vehicle) – Red/Red**

The above screen snapshots show the PC not able to connect to the DPA at all. Once the test is complete, the application will display an informational screen (image on the right) listing steps to potentially correct the issue.

10.2. **USB-Related Issues**

If you plug in a DPA (or any other USB device) and get the New Hardware Found wizard, do not click cancel. Go through the wizard completely! **IF YOU SELECT Cancel, THE DPA WILL NOT WORK!**
11. **DPA Options Program**

The DPA Options program allows you to set and configure various aspects of the DPA 5. The following sections describe the roles of the variables. The DPA 5 Bluetooth Configuration Utility is discussed later.

11.1. **DPA Options Notes; RP1210 DPA Driver Sets**

Version 2.0 (and higher versions) of the DPA Options program adds the capability of modifying the settings for all DPA driver sets that are installed on your computer. Below is a table that briefly describes each driver.

<table>
<thead>
<tr>
<th>Driver Set</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DG121032</td>
<td>DPA 4, 4 Plus and Prior DPAs (Single Application)</td>
</tr>
<tr>
<td></td>
<td>Allows only one RP1210 application to run at a time. Products supported by</td>
</tr>
<tr>
<td></td>
<td>this driver include DPA 4, DPA RF, DPA III Plus, and the DPA 4 Plus.</td>
</tr>
<tr>
<td>DPA4PSA</td>
<td>DPA 4 Plus Variants (Single Application)</td>
</tr>
<tr>
<td></td>
<td>Allows only one RP1210 application to run at a time.</td>
</tr>
<tr>
<td>DPA4PMA</td>
<td>DPA 4 Plus Variants (Multiple Application)</td>
</tr>
<tr>
<td></td>
<td>Allows more than one RP1210 application to run at a time.</td>
</tr>
<tr>
<td>DGDPA5MA</td>
<td>DPA 5 Variants (Multiple Application)</td>
</tr>
<tr>
<td></td>
<td>Allows more than one RP1210 application to run at a time.</td>
</tr>
<tr>
<td>DGDPA5SA</td>
<td>DPA 5 Variants (Single Application)</td>
</tr>
<tr>
<td></td>
<td>Allows only one RP1210 application to run at a time.</td>
</tr>
</tbody>
</table>

The **DPA 5 Bluetooth Configuration Utility** button will only be available if a DPA 5 API is selected.
11.2. Set Options for DPA Device/API

When selecting DPA Options from the program menu of an installed DPA driver set, the program should default this field to that particular DPA driver set. Note that you can only modify driver sets that have been installed.

If you want to modify an option for any DPA driver set, you select that DPA driver set with this field.

11.3. J1939 Fast Transport Layer (FAST_TRANSPORT Option)

When this option is in the On (Default) position, it significantly decreases reprogramming and reflashing times over the J1939 data bus by reducing the amount of time between J1939 transport protocol (TP) packets (used to break large messages into CAN 8-byte packets for transmitting on the data bus). With this option turned on, however, some PC applications and vehicle controllers may not be able to keep up with the DPA.

This option has long existed, and many OEM and component manufacturers using the DPA for end of line (EOL) programming stations have used it successfully. If you encounter a diagnostic or reprogramming/reflashing application that is having problems with the DPA using the J1939 protocol, we recommend setting this parameter temporarily to the Off position and then retrying the application.

This parameter makes little, if any, difference during standard diagnostic sessions.

11.4. Debug Logging Level (RP1210 INI Option DebugLevel)

This is an RP1210B introduced INI file option designed to record vehicle data bus data and other pertinent driver data to a text file. Chances are you will never need to use this, DebugFile, DebugFileSize, and DebugMode options unless you are directed by an OEM or DG to investigate possible software issues. Potential values for this option are:

- 0 = No Debugging to be Accomplished (Default).
- 1 = Only Connect/Disconnect/Error Messages.
- 2 = Add RP1210_SendCommand Calls.
- 3 = Add all Sent Messages (with Filtering).
- 4 = Add all Received Messages (with Filtering).

Changing this value to something besides 0 (the default) will cause the DPA drivers to start logging DPA driver and vehicle data bus data to the DebugFile based on the selected value.

11.5. Debug File Name (RP1210 INI Option DebugFileName)

When DebugLevel is on (1-4), this is the file that will receive the data logging output in text format. This file is in ASCII and can be read using a text editor. The default value for this option is in the Windows temporary directory, with a filename appropriate for the driver set.

11.6. Debug File Size (RP1210 INI Option DebugFileSize)

When DebugLevel is on (1-4), this is how large the DebugFile can grow in bytes. The formula is (DebugFileSize * 1024), so if you want to allow the DebugFileName the ability to grow to 2 megabytes, you would set this value to 2048. The default value for this parameter is 1024, or 1 megabyte.
11.7. Debug File Mode (RP1210 INI Option DebugMode)

When DebugLevel is on (1-4) and this option is in the 1 (Default) position, the DPA drivers will append data to DebugFile (which could have data from previous logging) until it reaches the end of the file (1024 * DebugFileSize). When reaching the end of the file, the DPA drivers will erase DebugFile and start writing new data to the file.

When DebugLevel is on and this option is in the 0 (Overwrite File Contents) position, the DPA drivers will erase DebugFile and begin writing data to the file until it reaches the end of the file (1024 * DebugFileSize). When reaching the end of the file, the DPA drivers will erase DebugFile and start writing new data to the file.

11.8. Automatic Firmware Update

Setting the variable Automatic Firmware Update to the Value causes the drivers to exhibit the behavior in the Action column.

<table>
<thead>
<tr>
<th>Value</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Automatic firmware update is turned off. No automatic checking for new firmware.</td>
</tr>
<tr>
<td>1</td>
<td>Automatic firmware update is turned on. The user has a choice as to whether or not to upgrade.</td>
</tr>
<tr>
<td>2</td>
<td>Automatic firmware checking is turned on. The user is only told that there is new firmware available and told they should run the DPA Firmware Updater. When the user chooses OK, then the drivers connect the application to the vehicle. The user can then update the DPA at their convenience.</td>
</tr>
<tr>
<td>3</td>
<td>Automatic firmware update is turned on. The user is told there is new firmware and the firmware is downloaded automatically as soon as they press the OK button. When the user selects OK, the firmware is automatically updated.</td>
</tr>
<tr>
<td>4</td>
<td>Automatic firmware update is turned on. The user is not prompted and the download begins automatically.</td>
</tr>
</tbody>
</table>

If the user selects Yes, the firmware is automatically updated. If the user chooses No, then the drivers connect the application to the vehicle. This is the default.
11.8.1. When the Drivers Call the DPA Firmware Updater

In the event that the automatic update is chosen, the DPA drivers launch the DPA Firmware Updater, which handles the downloading of new firmware. Once the firmware has started downloading, the user should not stop it. Aborting a firmware download may cause the device to become unresponsive and require the hardware to be shipped back to the manufacture for repair. The following is the dialog box showing the DPA Firmware Updater during an automatic update:

![DPA Auto Firmware Upgrade]

When the update is complete, the following dialog box is displayed and the DPA drivers attempt to let the application that was suspended continue executing. Most applications can handle the interruption; however there is a possibility that the user may have to restart their application.

![DPA Firmware Update Complete]

11.9. DPA 5 Bluetooth Configuration Utility

This button opens the DPA 5 Bluetooth Configuration Utility. This allows the user to create RP1210 DeviceID entries from DPA 5 Bluetooth Pairings. This utility has its own help file.
12. Running the Bluetooth Configuration Utility

After you have successfully paired your DPA 5 with the Bluetooth dongle and have created the Virtual COM Port, run the DG Bluetooth Configuration Utility to create an RP1210 DeviceID entry that can be seen by OEM software applications:

- Start ➔ Programs ➔ Dearborn Group Products ➔ DPA 5 ➔ DPA Options

![DPA 5 Options Program]

- Ensure the Bluetooth dongle is connected to the PC and that the DPA 5 has power
- Press the button DPA 5 Bluetooth Configuration Utility

You must go through this configuration utility to create RP1210 DeviceID entries. If you do not, the DPA 5 in Bluetooth mode will not work with your OEM applications!

What the DG Bluetooth Configuration Utility does is:

- Display existing DPA 5 Bluetooth RP1210 DeviceID pairings that are found in the DGPA5MA.INI file, allowing you to delete an RP1210 DeviceID pairing if you wish.
- Discover DPA 5 Bluetooth devices on Virtual COM Ports and create a new RP1210 DeviceID pairing that can be used by OEM software applications.

Note: The DPA 5 must have power in order to create the Virtual COM Port and RP1210 DeviceID pairing.
12.1. Creating a New RP1210 DeviceID from a Newly Paired DPA 5

After you have paired a DPA 5 with your PC and created a Virtual COM Port, click the Discover Bluetooth DPAs button. Any Bluetooth DPAs that you have paired with will be automatically added to the DGDPASMA.INI file. OEM applications will now be able to see and use that particular DPA 5 as RP1210 DeviceID=160.

NOTE: Sometimes the detection process through the virtual COM port does not see the DPA on the first attempt. If this is the case, try the discovery process again.

12.2. Deleting an RP1210 DeviceID

If you want to delete an RP1210 DeviceID, simply select that entry and click Delete Pairing. Note that after the RP1210 DeviceID has been deleted, it will NOT appear in OEM software applications for selection. For information on Bluetooth (including FCC and IC identification), see the Bluetooth Configuration Manual. It can be found in the Windows Start Menu.
13. Product Specifications

13.1. DPA 5 Physical and Electrical

<table>
<thead>
<tr>
<th>Feature</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>6.1 x 2.5 x 1.2 inches</td>
</tr>
<tr>
<td>Voltage Requirements</td>
<td>9 – 32 Volts DC</td>
</tr>
<tr>
<td>Current Requirements</td>
<td>250mA maximum through voltage range</td>
</tr>
<tr>
<td>Operating Temperature Range</td>
<td>-40 to +85C</td>
</tr>
<tr>
<td>Wired PC Communications Type</td>
<td>USB Version 1.1 or Higher</td>
</tr>
<tr>
<td>Wired Connection</td>
<td>Gold-plated USB Cable (up to 15 feet)</td>
</tr>
<tr>
<td>Wireless Connection</td>
<td>Bluetooth (DPA 5 Dual-CAN is equipped with Class 1 radio)</td>
</tr>
<tr>
<td>Vehicle-Side Connector</td>
<td>DB25 Female</td>
</tr>
<tr>
<td>PC-Side Connector</td>
<td>Standard B-Type USB Jack</td>
</tr>
<tr>
<td>PC Device Drivers</td>
<td>TMC RP1210C (RP1210B, RP1210A) Compliant Drivers DG Native Drivers</td>
</tr>
</tbody>
</table>

13.2. DPA 5 Pinouts

<table>
<thead>
<tr>
<th>Signal</th>
<th>DPA 5 Dual CAN/BT</th>
<th>DPA 5 Quad CAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ground</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>Power (9-32vdc)</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>J1708-</td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td>J1708+</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>CAN1 Shield</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>CAN1 Lo</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>CAN1 Hi</td>
<td>13</td>
<td>13</td>
</tr>
<tr>
<td>CAN1 Term 1</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>CAN1 Term 2</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>CAN TX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAN RX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SW CAN</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>ALDL/GM UART</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>ALDL RX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9141 K Line</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>9141 L Line</td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td>J1850 Hi</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>J1850 Lo</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ATEC Data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ATEC Diag</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Discrete In</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Discrete Out</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAN2 Term 1</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>CAN2 Term 2</td>
<td>21</td>
<td>21</td>
</tr>
<tr>
<td>CAN2 Shield</td>
<td>23</td>
<td>23</td>
</tr>
<tr>
<td>CAN2 Lo</td>
<td>22</td>
<td>22</td>
</tr>
<tr>
<td>CAN2 Hi</td>
<td>24</td>
<td>24</td>
</tr>
<tr>
<td>LIN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HALDEX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAN3 Lo</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CAN3 Hi</td>
<td>17</td>
<td></td>
</tr>
<tr>
<td>CAN3 Shield</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>CAN4 Lo</td>
<td>19</td>
<td></td>
</tr>
<tr>
<td>CAN4 Hi</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>CAN4 Shield</td>
<td>25</td>
<td></td>
</tr>
</tbody>
</table>

* Shunting these two pins (Term1/Term2) applies a 120-Ohm terminating resistor to the CAN/J1939 network.
* Pins that are not mentioned are reserved and should not have anything attached to them.
14. DG Update – Program Overview

DG Update is an application that is installed with your DPA drivers. It will run (by default) once every 30 days, and will keep you up-to-date with the latest versions of drivers for all your DPA, DG Diagnostics, and VSI-2534 products. With this application running regularly and Automatic Firmware Update (see DPA user manual) turned on, this will keep your DPAs up-to-date with drivers and firmware. DG recommends our customers keep up-to-date so that your OEM and component manufacturer diagnostic applications run smoothly.

The utility will run once every 30 days as a user logs on. This value is configurable, but defaults to 30 days. It can also be invoked manually from the Windows Start Menu:

Start ➔ Programs ➔ Dearborn Group Products ➔ DPA 5 ➔ DG Update

14.1. DG Driver Update – Internet Connection Required

The DG Driver Update utility depends on successfully connecting to the Internet (to one of DG’s servers) to retrieve the latest version information and to download the latest drivers and applications if necessary.

Many companies install firewalls and virus protection and these may block the DG server queries and responses. If you are connected to the Internet and have issues running DG Update (getting “Unable to connect to the internet to check for updates.” messages), ensure that your firewall or virus protection will allow a connection to the following Internet host/site and port: fh.dtech.com, port 8888. There are too many firewall and virus programs on the market to cover in this manual, however if you contact your network administrator and give him the host and port number, he should be able to configure your PC to allow the communication. You may also consult the Windows help system and/or the documentation for your firewall and/or virus protection software.

14.2. DG Driver Update – Initial Screen

When the utility runs as a user logs on, the following screen will appear in the lower right hand corner of the screen. If you want to check for updates, ensure that your PC is connected to the Internet and click Continue. Clicking Cancel will cause DG Update to wait until the next time it is scheduled to run. Clicking Continue will bring up the main update screen.
14.3. DG Driver Update – Main Update Screen

The main screen appears looking like this. Depending on which products are installed on your PC, the grid will display pertinent information about them. When selecting DG Update from the Windows Start Menu, this is the first screen to appear.

Connect your PC to the Internet and click the Check For Updates button. Due to the nature of TCP/IP communications, errors connecting or sending/receiving of data are slow to appear, however the user will eventually be notified if there was a problem.

If the check for updates was successful, the second column of the grid will display information returned from the DG server showing the most current versions and the Install Status row will change to red, green or blue.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Drivers up-to-date. No update necessary.</td>
</tr>
<tr>
<td>Red</td>
<td>Drivers are outdated. Update recommended.</td>
</tr>
<tr>
<td>Blue</td>
<td>Drivers on your PC are newer than current version. This usually indicates you are running a beta copy of the DPA drivers.</td>
</tr>
</tbody>
</table>

14.3.1. Successful Connect – No Updates Available

In this case, all drivers are current (green), and the Download button and progress bar do not display (see next paragraph). Clicking Exit will exit the program.
14.3.2. Successful Connect – Updates Available

In this case, the DPA 5 drivers are out of date (red), and the **Download** button and progress bar show up on the screen. The progress bar will keep you informed of the download progress should you choose to download the latest drivers by clicking the **Download** button.

When you click the **Download** button, you will be prompted to confirm starting of the download.

Note: The DG Update application can only download and install one item at a time. The user will be prompted for whichever one they want to update first. The reason that only one can be downloaded at a time is that the after the drivers are unzipped the installation program begins automatically. The DG Update program must exit because the installation program may have a newer version of the DG Driver Update utility to install.

After choosing **Yes**, the program will download the drivers and update the progress bar while doing so. Once the drivers have been downloaded, the application will unzip them and start the installation process. The dialog box will go away after the install has been started.

After the drivers have been downloaded (to the Windows temp directory – if you wish to save them for other machines), they will be unzipped and the program will exit right after starting the new driver installation. Follow the installation instructions in the appropriate User Manual.
14.4. **Advanced Settings – Setting Default Time for Check for Updates**

If you want to turn off, or alter the timeout period where the user is prompted to check for updates (the dialog below), press the **Advanced Settings** button.

The following dialog box will be displayed. To turn off the checking prompt, set the value to zero. Otherwise, you can set the number of days between checks.

![Dialog box showing options for setting default time for check for updates.](image)
15. Technical Support and Return Merchandise Authorization (RMA)

15.1. Technical Support

After reading and following the troubleshooting and validation procedures in Chapter 8 and not being able to resolve an issue, please feel free to contact DG technical support. For users in the United States, technical support is available from 9 a.m. to 5 p.m. Eastern Time. You may also fax or e-mail your questions to us. For prompt assistance, please include your voice telephone number.

Users not residing in the United States should contact your local DG representative.

DG Technologies Technical Support

Phone: (248) 888-2000
Fax: (248) 888-1188
E-mail: techsupp@dgtech.com
Web site: www.dgtech.com

15.2. Return Merchandise Authorization (RMA)

If technical support has deemed that there may be a physical problem with your DPA, you will be issued you an RMA number. You would then return the product along with any documentation of ownership you have (proof of purchase/price) to the following address:

Product Service/Repairs
Attn: RMA# xxxxxxx
DG Technologies
33604 West 8 Mile Road
Farmington Hills, MI 48335
16. Warranty Information and Limitation Statements

16.1. Warranty Information

The Dearborn Group, Inc. DPA 5 is warranted against defects in materials and workmanship for two (2) years following date of shipment. Cables (both USB and vehicle) are warranted for 90 days.

Dearborn Group, Inc. will, at its option, repair or replace, at no cost to the customer, products which prove to be defective during the warranty period, provided the defect or failure is not due to misuse, abuse, or alteration of the product. The customer is responsible for shipment of the defective product to DG. This warranty does not cover damage to any item that Dearborn Group, Inc. determines has been damaged by the customer's abuse, misuse, negligence, improper assembly, modification, or operation of the product.

A Return Merchandise Authorization (RMA) number must be issued to the customer by our Technical Support Department at (248) 888-2000 and must be included with the product being returned (for more details, see section Return Merchandise Authorization (RMA)). A DPA is warranted for 90 days after a warranty repair, or to end of the original factory warranty period, whichever is longer.

16.2. Limitation Statements

16.2.1. General Limitation and Risk Assignment

To the maximum extent permitted by applicable law, Dearborn Group, Inc. and its suppliers provide support services on an "as-is" basis and disclaim all other warranties and conditions not specifically stated herein, whether express, implied or statutory, including, but not limited to, any warranties of merchantability or fitness for a particular purpose, lack of viruses, accuracy or completeness of responses, results, lack of negligence or lack of workmanlike effort, and correspondence to description. The user assumes the entire risk arising out of the use or performance of the device, its operating system components, and any support services.

16.2.2. Exclusion of Incidental, Consequential and Certain Other Damages

To the maximum extent permitted by applicable law, in no event shall Dearborn Group, Inc. or its suppliers be liable for any special, incidental, indirect or consequential damages whatsoever, including but not limited to: damages for loss of profit, loss of confidential or other information; business interruption; personal injury; loss of privacy, failure to meet any duty (including good faith or of reasonable care); negligence; and any other pecuniary or other loss related to the use of or the inability to use the device, components or support services or the provision of or failure to provide support services or otherwise in connection with any provision, even if Dearborn Group, Inc. or any supplier has been advised of the possibility of such damages.

16.2.3. Limitation of Liability and Remedies

Notwithstanding any damages that you might incur for any reason whatsoever (including, without limitation, all damages referenced above and all direct or general damages), in no event shall the liability of Dearborn Group, Inc. and any of its suppliers exceed the price paid for the device. The user assumes the entire risk and liability from the use of this device.

16.2.4. Right to Revise or Update without Notice

Dearborn Group, Inc. reserves the right to revise or update its products, software and/or any or all documentation without obligation to notify any individual or entity.

16.2.5. Governance

The user agrees to be governed by the laws of the State of Michigan, USA, and consents to the jurisdiction of the state court of Michigan in all disputes arising out of or relating to the use of this device.

16.2.6. Contact

Please direct all inquiries to:

Dearborn Group, Inc.
33604 West 8 Mile Road
Farmington Hills, MI 48335
Phone (248) 888-2000
Fax (248) 888-1188
17. Appendix A – DPA 5 Manual Firmware Update

Even though automatic firmware update comes defaulted to on, there may be a time you need to update your DPA firmware manually. The first step in a manual firmware update is to find which version of firmware you have. You can use the AVT utility after connecting the DPA to a power source.

Start ➔ Programs ➔ Dearborn Group Products ➔ DPA 5 ➔ Adapter Validation Tool

Select the correct DPA adapter:

- **Vendor**  DGDPA5MA – Dearborn Group DPA 5 Multiple Application
- **Device**  1 – DG DPA 5 Dual-CAN USB - USB
- **Protocol**  J1708 (any protocol works)

Then click the Run Test button. When the test has finished running, go to the RP1210 Status Window and scroll down to the line that reads [RP1210_ReadDetailedVersion] and look for the entry “FW=”. The last numbers on the line indicates which version of firmware you have (note the yellow circle). If you are not at the correct level (see manual cover page for which version you should be at), then you need to run the DPA Firmware Updater outlined in the following steps.
17.1. **Launch the DPA Firmware Updater Program**

1. Stop all applications that are using the DPA 5 (if any).

2. Start the DPA Firmware Updater program:

   ![DPA Firmware Updater Program Screenshot]

   Start ➔ Programs ➔ Dearborn Group Products ➔ DPA 5 ➔ DPA Firmware Updater

3. Select the correct firmware file (the latest version is already selected by default). If the firmware file exists, the Firmware box will turn green.
   
   a. **NOTE:** Firmware files are located in separate sub-directories under the Utilities directory where the DPA drivers are installed, typically:
      
      C:\Program Files\Dearborn Group Products\DPA 5\Utilities\DPA5_Firmware

4. Click on the **Update Firmware** button and select **Yes** if you receive a warning dialog.

5. After the download is finished, disconnect power from the DPA, wait 5 seconds and then reconnect power.
18. Appendix B – Software Developer/Integrator Notes

This section is relevant only to software development engineers and systems integrators.

18.1. Bundling the DPA with Your OEM Installation – Silent Install

DG has introduced a silent installation that software installation engineers can call that will install all DPA files that would normally be installed by running the installation interactively.

- The silent installation does not prompt the user or display a screen at any point.
- After the install, a reboot of the PC is necessary.

18.1.1. Silent Install Command Line

DPA5Install.exe /s /d_SILENT_=\[components to install\]

The [components to install] can be any combination of the following:
- A = DG DPA 5 Dual CAN USB drivers and associated files
- B = DPA 5 Bluetooth drivers and associated files
- C = DG DPA 5 Quad CAN USB drivers and associated files

Examples:

Silently install DPA 5 drivers with Bluetooth Option:
DPA5Install.exe /s /d_SILENT_=AB

NOTE: Please test and ensure that the command line you provide is correct. Otherwise, only the baseline components will be installed, but the RP1210 API will not be functional.

18.1.2. Controlling Automatic Firmware Update Variable on Silent Install

If you are a software development engineer or system integrator and wish to use the silent installation, but you want to change the *Automatic Firmware Update* setting to a value other than “1” (default), you can do so by changing the registry value of the following variable during a post-installation event.

DPA 4 Plus (DG121032)

HKEY_LOCAL_MACHINE\SOFTWARE\Dearborn Group Products\FirmwareUpdater\UpdateFirmware

DPA 4P (DPA4PMA, DPA4PSA)

HKEY_LOCAL_MACHINE\SOFTWARE\Dearborn Group Products\FirmwareUpdaterDPA4P\UpdateFirmware

DPA 5 (DGDPA5MA, DGDPA5SA)

HKEY_LOCAL_MACHINE\SOFTWARE\Dearborn Group Products\FirmwareUpdaterDPA5\UpdateFirmware

This variable is of the REG_SZ data type, however only the first character (‘0’, ‘1’, ‘2’, ‘3’) is used by the DPA Options program and the DPA drivers.
19. Appendix C – FCC and Certification Industry Canada Information

The DPA 5 has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules (see the back of the DPA 5 for FCC and IC specific identifications). These limits are designed to provide reasonable protection against harmful interference in a residential installation. The DPA 5 uses and generates radio frequency energy. If not installed and used in accordance with the instructions, it may cause harmful interference to radio communications. If the DPA 5 does cause harmful interference to radio or television reception, which can be determined by turning the affected equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving and/or sending antennas.
- Increase the separation between the DPA 5 and the affected receiving equipment.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

This product complies with FCC OET Bulletin 65 radiation exposure limits set forth for an uncontrolled environment.

19.1. Industry Canada

Operation of the DPA 5 is subject to the following two conditions:

1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesired operation.

Changes not expressly approved by Dearborn Group, Inc. to the DPA 5 could void the user's authority to operate the DPA 5. The following is a sample rear label from the DPA 5 depicting the FCC and IC identifiers.

The following are the DPA 5 Bluetooth details as required to be published by the FCC.

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Frequency</td>
<td>2.4GHz</td>
</tr>
<tr>
<td>Power Output Maximum</td>
<td>&lt; 4.4dBi</td>
</tr>
<tr>
<td>Contains Transmitter Module FCC ID</td>
<td>QOQWT11</td>
</tr>
<tr>
<td>Transmitter Bluetooth QDID</td>
<td>B012647</td>
</tr>
</tbody>
</table>
20. Appendix D - Windows Vista and Windows 7 Support Notes

Microsoft® has made great strides in updating their operating systems to protect against malicious software. With Windows Vista, Microsoft introduced User Account Control (UAC). **UAC strictly enforces** the differences between an administrator and a standard user account. When an action that could potentially compromise the PC such as writing files to the C:\Windows directory or registry is requested, the user is prompted for an administrator name and password. If the user is already an administrator, they are **still** prompted to confirm the action. Generally speaking, whenever you see the Microsoft security shield 🟢 icon on a button, you will need an administrator’s password to perform that operation.

20.1. UAC and the TMC RP1210 Standard

Before Windows Vista, it was common for applications to put INI and other types of configuration files in the default Windows directory, typically C:\Windows. The RP1210A standard requires that the RP121032.INI file be located in this directory, along with all of the vendor INI files. On Windows Vista, this means that a standard user cannot make changes to the main RP121032.INI file, nor can they make changes to the vendor INI files when UAC is enabled.

20.2. UAC and the Dearborn Group Adapter Validation Tool (AVT)

A standard user will be able to run the AVT program and troubleshoot the PC-DPA-vehicle connection, but will not be able to fix a problem in the RP121032.INI file without an administrator password (see section on troubleshooting later in this document). The graphic below is from the Adapter Validation Tool (AVT), showing the Microsoft security shield on the **Fix/Change RP121032.INI File** button.

![Fix/Change RP121032.INI File](image)

20.3. UAC Requirements for All DPA Utility Programs

The DPA utility programs (listed below) have been modified to conform to UAC. The following list shows these programs and privileges required to run them:

<table>
<thead>
<tr>
<th>Program</th>
<th>Privileges Required</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter Validation Tool (AVT)</td>
<td>Standard User</td>
<td>Administrator needed for <strong>Fix/Change RP121032.INI File.</strong></td>
</tr>
<tr>
<td>DPA Options</td>
<td>Administrator</td>
<td></td>
</tr>
<tr>
<td>DG Diagnostics</td>
<td>Standard User</td>
<td>Cannot save/record data bus files to a protected directory.</td>
</tr>
<tr>
<td>DPA Firmware Updater</td>
<td>Standard User</td>
<td></td>
</tr>
<tr>
<td>Sample Source Code</td>
<td>Standard User</td>
<td></td>
</tr>
<tr>
<td>Bluetooth Configuration</td>
<td>Administrator</td>
<td></td>
</tr>
<tr>
<td>DG Update</td>
<td>Standard User</td>
<td>Standard user can use program but install of new drivers will prompt the user for the administrator password.</td>
</tr>
</tbody>
</table>

20.4. More Information on UAC

For more detailed information on UAC, there is a helpful article at [http://www.wikipedia.org](http://www.wikipedia.org) or you can go directly to the Microsoft website [http://www.microsoft.com](http://www.microsoft.com) and search for “UAC”.
21. Appendix E – DPA Utilities Information for This Release

The DPA utility applications (i.e. AVT, DGD, DPA Options) are common amongst all DPA products and have been split into their own release called **DPA Utilities**. This allows DG to distribute changes to these applications without having to release a new DPA DLL for every API (i.e. DGDA5MA, DGDA4PMA, DG121032). Since DG Update looks for this separate installation, it handles downloads and updates to the utility applications.

The version of DPA Utilities installed with this DPA API included:

<table>
<thead>
<tr>
<th>Utility</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter Validation Tool (AVT)</td>
<td>3.1</td>
</tr>
<tr>
<td>FixINI</td>
<td>3.1</td>
</tr>
<tr>
<td>DG Diagnostics</td>
<td>2.82</td>
</tr>
<tr>
<td>DG Update</td>
<td>1.53</td>
</tr>
<tr>
<td>DPA Firmware Updater</td>
<td>5.51</td>
</tr>
<tr>
<td>DPA Options</td>
<td>2.52</td>
</tr>
<tr>
<td>DPA 5 Bluetooth Configuration Utility</td>
<td>1.51</td>
</tr>
<tr>
<td>RP1210 Sample Source Code/EXE – C Language</td>
<td>2.65</td>
</tr>
<tr>
<td>RP1210 Sample Source Code – Python Language</td>
<td>1.1</td>
</tr>
<tr>
<td>J2534 Sample Source Code/EXE – C Language</td>
<td>1.21</td>
</tr>
</tbody>
</table>
## Appendix F – List of Acronyms Used in this Document

Various acronyms have been used throughout this document.

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>API</td>
<td>Application Programming Interface</td>
</tr>
<tr>
<td>AVT</td>
<td>Adapter Validation Tool</td>
</tr>
<tr>
<td>CAN</td>
<td>Controller Area Network</td>
</tr>
<tr>
<td>CD</td>
<td>Compact Disk</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>Compact Disk - Read Only Memory</td>
</tr>
<tr>
<td>DG</td>
<td>Dearborn Group</td>
</tr>
<tr>
<td>DPA</td>
<td>Dearborn Protocol Adapter</td>
</tr>
<tr>
<td>DTC</td>
<td>Diagnostic Trouble Codes</td>
</tr>
<tr>
<td>ID</td>
<td>Identification</td>
</tr>
<tr>
<td>ISO</td>
<td>International Standards Organization</td>
</tr>
<tr>
<td>JVT</td>
<td>J2534 Validation Tool</td>
</tr>
<tr>
<td>LED</td>
<td>Light Emitting Diode</td>
</tr>
<tr>
<td>OBD</td>
<td>On Board Diagnostics</td>
</tr>
<tr>
<td>OEM</td>
<td>Original Equipment Manufacturer</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>RP</td>
<td>Recommended Practice (see TMC)</td>
</tr>
<tr>
<td>SAE</td>
<td>Society of Automotive Engineers</td>
</tr>
<tr>
<td>TMC</td>
<td>Technology and Maintenance Council</td>
</tr>
<tr>
<td>UAC</td>
<td>User Account Control</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>VDA</td>
<td>Vehicle Datalink Adapter</td>
</tr>
</tbody>
</table>
23. Appendix G. Testing and Troubleshooting of a J1939 Network

23.1. J1939 Network Types

There are two standards that OEMs follow when designing their CAN/J1939 network, J1939-11 and J1939-15.

23.1.1. J1939-11

The J1939-11 standard calls for twisted-pair wire with a shield. The shield is typically grounded at the engine ECM or negative battery post and must only be grounded at one spot on the vehicle. This standard is not commonly implemented because of the added cost of the shielding. The main issues with this network are too many, or too few, termination resistors (see Figure G2) or breaks in wire and insulation due to kinks, and vibration. This standard calls for the external termination resistors shown in Figure G2.

23.1.2. J1939-15

The J1939-15 standard calls for twisted-pair wire without a shield and is the most widely adopted. The main issues with this network are breaks in the wire and insulation due to kinks, vibration and rubbing, wire and connector corrosion, and too many, or too few, termination resistors. In the J1939-15 specification, termination resistors are commonly found inside of ECMs which are easily “activated” by shunting several pins at that ECMs connection to the vehicle wiring harness. This configuration makes it very easy to have a termination resistor problem and is much more difficult to diagnose.

23.2. CAN/J1939 Termination Resistor

The following image shows a picture of a 120 Ohm resistor typically found within vehicle ECMs and an image of a J1939 termination resistor that is commonly found on J1939-11 networks.

![Figure G1](image1.png)

Image of a 120 Ohm resistor.
Brown, Red, Brown with +/- 5% tolerance (Gold)

![Figure G2](image2.png)

Image of J1939 Terminating Resistor on J1939-11 Network (Twisted Shielded Pair)
23.3. **Properly Terminated J1939 Network (Term Resistors at Logical End Points)**

![Diagram of properly terminated J1939 network with 120 Ohm terminating resistors at logical end points for Engine, Transmission, ABS, Other Devices, and Diagnostic Connector.]

23.4. **Aftermarket Additions Improperly Installed**

Aftermarket add-ons can cause J1939 network issues by over-terminating the J1939 databus.

![Diagram of improperly terminated J1939 network with a faulty telematics or aftermarket installation represented by a red box with 120 Ohm terminating resistor and diagnostic connector.]

23.5. **J1939 Network Testing Step 1 (Termination Resistance)**

To test for proper CAN/J1939 network termination requires standard hand tools and a standard Volt/Ohm meter. Follow these steps:

1. Completely power down the vehicle. This is done at the battery disconnect, or by removing the positive terminal from the battery.
   
   a. This step cannot be bypassed as invalid values will affect the test outcome.

2. With Ohm meter, measure the resistance between pins C (CAN/J1939 High) and D (CAN/J1939 Low) on the 9-pin Deutsch diagnostic connector. If you are not working on a heavy-duty vehicle, read your vehicle/equipment literature as to where **CAN High** and **CAN Low** can be found.

<table>
<thead>
<tr>
<th>Value Obtained</th>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Greater than 120 Ohms</td>
<td>Open circuit or missing a terminating resistor.</td>
<td>Install a terminating resistor at the network end. See OEM literature for terminating resistor location and for further troubleshooting information.</td>
</tr>
<tr>
<td>Less than 44 Ohms</td>
<td>More than two terminating resistors or J1939 wires are shorted together somewhere.</td>
<td>Remove extraneous terminating resistors by reading OEM literature for where the two terminating resistors should have been installed.</td>
</tr>
</tbody>
</table>

To test for CAN/J1939 wire shorts to ground requires standard hand tools and a standard Volt/Ohm meter. Follow these steps:

1. Completely power down the vehicle. This is done at the battery disconnect, or by removing the positive terminal from the battery.
   a. This step cannot be bypassed as invalid values will affect the test outcome.

2. With Ohm meter, measure the resistance between pins C (CAN/J1939 High) and A (Ground). Then measure the resistance between pins D (CAN/J1939 Low) and A (Ground). If you are not working on a heavy-duty vehicle, read your vehicle/equipment literature as to where CAN High, CAN Low and Ground can be found.

<table>
<thead>
<tr>
<th>Value Obtained</th>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>About 10k Ohms or Greater</td>
<td>No shorts to ground.</td>
<td>Try Step 3.</td>
</tr>
<tr>
<td>Less than 10k Ohms</td>
<td>Wire shorted to ground.</td>
<td>Repair or replace J1939 harness. See OEM literature for further testing of individual data bus wiring, and potential replacement of databus segments.</td>
</tr>
</tbody>
</table>
23.7. J1939 Network Testing Step 3 (Roll Call)

To test for controllers transmitting on the databus (commonly called Roll Call) and potentially leaving the databus because of an error condition (BUS_OFF) requires a Dearborn Group DPA device, a personal computer (PC) with drivers for that DPA device installed, and a copy of DG Diagnostics software (free with purchase of a DPA device). For more information on DG Diagnostics see the DPA User Manual (available from the Start -> Programs menu).

1. Power up the vehicle and turn ignition switch on.
2. Connect DPA device to the vehicle/equipment diagnostic connector.
3. Start DG Diagnostics by using the shortcut icon on the desktop. On the Home tab, select the correct DPA and Device and click Connect button.
4. Go to the Components tab. Wait for 30 seconds to ensure all ECMs that are supposed to be transmitting on J1939 are listed (top arrow).
   a. If a component is not transmitting that should be, refer to the OEM literature on how to diagnose that component.
5. Press the Reset Lists button and wait another 30 seconds. If a controller has disappeared, then that controller has went into a BUS_OFF state indicating something is wrong with that components ability to transmit on the CAN/J1939 data bus.
   a. Refer to the OEM literature on how to fully diagnose that component.
24. Appendix H. Commonly Requested Cable Drawings

24.1. DPA 4 Plus to DPA 4 Plus “Back-to-Back” Cable

This cable is for use with a second PC running a simulator or other software.

Banana Jacks

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>8</td>
<td>Power</td>
</tr>
<tr>
<td>14</td>
<td>J1708/J1587 Lo</td>
</tr>
<tr>
<td>15</td>
<td>J1708/J1587 Hi</td>
</tr>
<tr>
<td>12</td>
<td>CAN/J1939 Lo</td>
</tr>
<tr>
<td>13</td>
<td>CAN/J1939 Hi</td>
</tr>
<tr>
<td>3</td>
<td>CAN/J1939 Term Resistor</td>
</tr>
<tr>
<td>4</td>
<td>CAN/J1939 Term Resistor</td>
</tr>
<tr>
<td>10</td>
<td>SWCAN</td>
</tr>
<tr>
<td>1</td>
<td>GMUART/ALDL</td>
</tr>
<tr>
<td>5</td>
<td>GM J1850 VPW Hi</td>
</tr>
</tbody>
</table>

DB15 Male

© 2010-2013 Dearborn Group, Inc.
24.2. **DPA 5 to DPA 5 “Back-to-Back” Cable**

This cable is for use with a second PC running a simulator or other software.

![Diagram of DB25 Male connectors and Banana Jacks showing pin connections.]

- **Ground (Pin 6)**
- **Power (Pin 8)**
- **J1708/J1587 Lo (Pin 14)**
- **J1708/J1587 Hi (Pin 15)**
- **CAN 1/J1939 Lo (Pin 12)**
- **CAN 1/J1939 Hi (Pin 13)**
- **CAN 1/J1939 Term Resistor (Pin 3)**
- **CAN 1/J1939 Term Resistor (Pin 4)**
- **SWCAN (Pin 10)**
- **GMUART/ALDL (Pin 16)**
- **GM J1850 VPW Hi (Pin 5)**
- **ISO9141 K-Line (Pin 1)**
- **ISO9141 L-Line (Pin 11)**
- **CAN 2/J1939 Lo (Pin 22)**
- **CAN 2/J1939 Hi (Pin 24)**
- **CAN 2/J1939 Term Resistor (Pin 20)**
- **CAN 2/J1939 Term Resistor (Pin 21)**

**DB25 Male**